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September Club Meeting - 7:30pm Thursday 10th
at the Canberra Irish Club, 6 Parkinson Street, Weston
2009 PROGRAM
WHAT
There are plenty of photographic opportunities on the
walk to the falls, at the falls and also all along the river.
I plan to be at the Polo Flat Truckstop, Cooma at 10am
for morning tea, then leave there at 10:30 and get to
the Little Cascades carpark by 11:30 am, weather
permitting, for a pre lunch walk to the Tuross Falls.
Once we get back, at around 12:30, we can have a
picnic lunch by the river and then maybe have a walk
in another direction after lunch.

PRESENTATIONS
Month

Presentation
Coordinator

&

September

Landscape Photography
(Robert Deane)

October

Travel Photography

November

Photobooks

HOW TO GET TO THE POLO FLAT TRUCK
STOP, COOMA

EXCURSIONS
Month

Excursion
Coordinator

&

•

19th September

Little Cascades (Sandie
Walters)

•
•

October

Coast Trip: Eden

24th & 25th October

Open Gardens (Pamela
Finger)

Drive to Cooma (about 100km’s), but just as you
get to Cooma,
Turn Left onto Polo Flat road
Go just past the Numeralla Road intersection and
on the left hand side, you’ll see a steep pitched
roof. That’s the Polo Flat Truck Stop (Caltex)

We will LEAVE the Polo Flat Truckstop at 10:30am

LITTLE CASCADES CARPARK
•

SPECIAL INTEREST GROUPS
See end of Newsletter for Photoshop SIG program.

•

SEPTEMBER EXCURSION

•

LITTLE CASCADES
•

WHEN

19th September 2009
Meet at the Polo Flat Truckstop at 10:15am, or at the
Little Cascasdes carpark. See instructions below

•
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Drive to Cooma (about 100km’s), but just as you
get to Cooma,
Turn Left onto Polo Flat road. Go for less than
1km
Turn left a the Cooma Numeralla Road. Go for
about 19kms. Go through Numeralla and
continue on the Numerala Countegany Road for
about 12kms. It veers onto the Badja Road
towards the end.
Turn Right on the Badja Forest Road (becomes
dirt) and go for about 4½ kms
Turn Right at Peters Road (sign post “Cascades”)
and go for about 1½kms
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•
•

Turn or veer Right onto Tuross Falls Road and
follow till end
Veer right to stay in the top carpark rather than go
down to the campground

USING DIGITAL IMAGES IN DOCUMENTS,
PRESENTATIONS AND DISPLAYS

CARPOOLING

Margaret Brown

If you have a low, city type car, then it might be
sensible to get a lift with someone with a bit more
clearance. The Tuross River Road is quite passable
with a normal two wheel drive, but if unsure, don’t risk
it. If you do want a lift, please let me know. Also, if
you have a large four wheel drive and have spare
space, please let me know.

Digital photographs that have been taken with a high‐
resolution camera using the highest resolution and
quality settings are too large to be emailed directly and
can be inconvenient to include in PowerPoint
presentations. But it's very easy to re‐size them and
there are a number of ways to do so.
1. Some cameras have a function that automatically
creates and saves a small copy of the picture at the
appropriate resolution for emailing.
2. Most editing software has facilities for resizing
digital pictures, although some applications provide
few controls over the dimensions and resolution of the
end result.
3. Image sharing websites like Flickr (www.flickr.com),
Snapfish (www.snapfish.com.au), and PhotoBucket
(www.photobucket.com) provide automatic resizing
when pictures are uploaded.

QUESTIONS
If you have any questions, call Sandie on 0414 325 854

However, the process is so simple and straightforward,
it's worth learning how to do it yourself because then
you can control exactly how large ‐ and at what
resolution ‐ your pictures are duplicated.
Standard Picture Sizes & Resolutions
Before you start resizing pictures, it's important to
know the standard resolutions for various end‐uses.
Essentially four resolutions are in common use:
* 72 pixels per inch (ppi) for emails and images that
will be used in web‐based applications (websites,
browsers, online catalogues) and screen‐based viewing
(computer and video monitors).
* 92 ppi for PowerPoint presentations.
* 96 ppi for high‐definition monitors and TV screens.
* 300 ppi for prints and documents that will be printed
(see Chapter 7 on Printing Digital Photos).
When resizing pictures for viewing on a computer or
TV monitor, you should also take account of the native
resolution of the screen itself. Most monitors can
display a range of resolutions, from 640 x 480 pixels,
through to 3200 x 2400 pixels. The ideal resolution for
a standard 4:3 aspect ratio display for image editing is
between 1280 x 1024 pixels and 1920 x 1440 pixels.
Widescreen displays typically range between 1280 x
800 pixels and 1440 x 900 pixels.
If your picture size matches the monitor's display
parameters, the picture should fill the screen when it is
opened. Pictures that are smaller will open at a smaller
Page 2

F22: Southside Camera Club Newsletter September 2009
size, while larger pictures are usually automatically re‐
sized to fit the screen. (This re‐sizing is for display only
and will not affect the actual file size.)

Clicking on OK automatically resizes the images in the
folder and opens the selected email program.
Picasa2 also provides an option for sending image files
at full resolution but only when images are sent one
photo at a time. Video clips can also be re‐sized for
emailing but, because even small movie files tend to
be very large, both the Picasa Mail and Gmail services
limit each message to a maximum of 10 MB. (Note:
Some ISPs will not allow their clients to accept such
large file sizes.)
Another useful batch resizing program is Irfanview,
which is available from www.irfanview.com. This
freeware graphic viewer is fast and supports a huge
variety of file types. It also includes an emailing facility,
multimedia player, searching and printing functions.
Basic editing controls are also provided.

CHANGING THE RESOLUTION SETTING ON YOUR
MONITOR DISPLAY WILL ALSO CHANGE THE
SIZE AT WHICH PICTURES AND TEXT WILL BE
DISPLAYED. THE IDEAL RESOLUTION FOR A
STANDARD 4:3 ASPECT RATIO DISPLAY FOR
IMAGE EDITING IS BETWEEN 1280 X 1024
PIXELS AND 1920 X 1440 PIXELS. (NOTE: THIS
DIALOG BOX REFERS TO A DUAL-MONITOR SETUP.)

Resizing for Emails
Picasa2 (www.picasa.com) provides one of the easiest
ways to re‐size a batch of pictures for emailing. Simply
find the album of shots you wish to send and click on
Tools>Options>Email. Under the Output Options
menu, set the slide bar under "When sending more
than one photo, resize to:" to the desired pixel size.
(The default 480 pixel width is fine for portrait‐format
shots but you should slide the bar to the right to a
resolution setting of 640 pixels for landscape format
shots.)

PICASA2 WILL ALLOW YOU TO CHOOSE THE EMAIL
PROGRAM FOR SENDING YOUR PICTURES.
Microsoft has a freeware 'PowerToy" application called
Image Resizer that allows users of Windows XP to
resize one or many image files. It's available from
www.microsoft.com/windowsxp/downloads/powertoy
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s/xppowertoys.mspx. The 521 KB file is very quick to
download. Users simply right‐click on the selected
file(s) and choose from four different size options:

Format>Background and selecting an appropriate
background colour from the palette. (If the colour you
want is not displayed, click on More Colours to access
the full palette range.) Click on Apply to All.

IRFANVIEW'S BATCH RESIZING FACILITIES ALLOW
PHOTOGRAPHERS TO RE‐SIZE MANY FILES AT THE
SAME TIME.
* Small (which fits a 640 x 480 pixel screen),
* Medium (which fits an 800 x 600 pixel screen),
* Large (which fits a 1024 x 768 pixel screen),
* Handheld PC (which fits a 240 x 320 pixel screen).
No provision is made for larger screen sizes or
widescreen TV sets but all four settings can be useful
for re‐sizing shots for emailing. Use the Handheld PC if
you're emailing pictures to a camera‐phone.

WE'VE USED IRFANVIEW TO RE‐SIZE ALL THE
PICTURES IN A FOLDER AND SAVE THEM IN A NEW
FOLDER, FROM WHERE WE WILL COLLECT THEM
WHEN
ASSEMBLING
OUR
POWERPOINT
PRESENTATION.

Resizing for PowerPoint Presentations
Microsoft's PowerPoint is a popular business tool that
can also be used for creating simple slideshow‐style
presentations for displaying a set of photographs on a
computer screen. It's best to set up a special folder
containing the image files you wish to use in your
presentation and then re‐size these images as a batch.
Match the size of the images to the screen on which
they will be displayed (for example, 1024 x 768 pixels
for a typical computer screen) and set the resolution to
92 ppi.

Step 3: Insert your picture. Select Insert>Picture>From
File. Then locate the file you wish to use in your re‐
sized pictures folder. Click on this picture then click on
'Insert' to superimpose the picture on the slide. If it's
the wrong size, you can adjust by positioning the
cursor over one of the dots on the edges of the picture
and dragging them in or out. This does not adjust the
actual size of the image file.

PowerPoint contains its own image re‐sizing facility but
it does not reduce file sizes. Consequently, if you have
shot your pictures with a high‐resolution camera, you
will quickly reach the data‐handling limit of the
software.
Problems are likely to occur if your presentation file is
40MB or larger. You can produce an excellent
presentation that is much smaller in size by re‐sizing
the image files before you begin to assemble it.
Step 1: Resize the images in another application and
save them in a separate folder.
Step 2: Open PowerPoint and select blank
presentation, choosing the blank page from the
Content Layouts menu.
You can change the background colour by clicking on
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Step 4: To create the next slide, click Insert>New slide
and insert and position your next picture(s). It is
possible to place two or more pictures on a single slide
but, remember, PowerPoint does not re‐size the image
files so putting several pictures on one slide can create
quite large files.
Step 5: When you have completed your presentation,
it's worthwhile checking the file size to make sure it is
not too large. Here's how to go about it:
On a Mac
1. Quit out of PowerPoint.
2. Click once on the icon for your PowerPoint
presentation to select it.
3. From the File menu choose Get Info>General
Information
4. In the window that appears look for the Size of the
presentation

If you wish to add a title at this point, select
Insert>Text Box and draw the text box over the area
where you wish to locate it, keeping the mouse button
held down while you position and adjust it. Then type
your title into the box. PowerPoint provides a variety
of text styles and colours to choose from.

On a PC
1. Quit out of PowerPoint.
2. Right‐Click on the icon for your PowerPoint
presentation.
3. In the menu that appears, choose Properties.
4. In the window that appears look for the Size of the
presentation.

INDUSTRY NEWS
While the average family takes hundreds of digital
photos and video clips each year, various research
indicates that less than half edit their photos and
fewer still edit their videos. As a result, digital
memories sit dormant on family computers without
ever being enjoyed or shared. Why? Because most
people just haven't found photo editing and video
editing on the PC to be the simple and rewarding
experience they're looking for. Corel Digital Studio
2010 responds to this need by bringing together
photo, video, DVD burning and playback, all within
one easy, fun and engaging environment.

SOFTWARE
COREL® DIGITAL STUDIO 2010

Corel
Corporation
(NASDAQ:CREL) (TSX:CRE)
introduced its all‐new
photo and video product
Corel® Digital Studio 2010.
Now TM it is simple, fast
and fun for everyone to
enjoy and share their
favourite photos and videos all within one integrated
and engaging environment.
Offering an elegant design and intuitive tools, Corel
Digital Studio inspires creativity and confidence by
making it easy for anyone to create beautiful photo
and video projects with no previous experience
required.

With Corel Digital Studio 2010, all your photos and
videos come together in one simple creative
experience. Whether you are making one‐click fixes
to your photos and videos, creating a photo book,
making slideshows or home movies complete with
your own soundtrack, or burning high‐definition
DVDs, you'll enjoy the same elegant look and feel
across the Studio. In this integrated and intuitive
environment, once you learn how to do one task,
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you'll quickly know how to do them all.

•

"With Corel Digital Studio, PC users finally have a
simple, fast and fun way to enjoy their photos and
videos, and create something amazing that they can
share with others," said Daniel Weisbeck, Corel's
Vice President, Global Product Marketing. "With its
simple, elegant design and intuitive, all‐in‐one
approach, Corel Digital Studio removes barriers,
inspires creativity and gives everyone the ability to
create and share something memorable in just
minutes."

All Your Media in One Place: The Media
Organizer brings all your photos and videos
together so you can more easily search, find
and organize your favorite memories. You
can also access your music library to add
your own personal soundtrack to
slideshows and home movies. The Media
Organizer is the starting point for all your
projects, making it easy to move from one
task to another.

•

Online Sharing Has Never Been Easier:
Share your files and projects any way you
choose. Use email, Flickr , Facebook and
YouTube , or send to your TM TM TM
mobile device. With Corel Digital Studio,
connecting with friends and family is just a
few clicks away.

•

Simple Backup and Burn: Backup and
protect your photo and video memories,
burn a professional looking DVD complete
with Hollywood‐style menus, or create
audio CDs and MP3 discs by simply dragging
and dropping. It's never been this easy.

Corel Digital Studio 2010 is designed to take
advantage of the latest Microsoft® Windows® 7
advances including the natural, hands‐on experience
offered by Windows Touch. The product also offers a
great creative environment for customers using
Windows® XP or Windows Vista®. Corel Digital Studio
2010 is just one example of the design innovation
that resulted in Microsoft naming Corel its Global ISV
Consumer Partner of the Year in June 2009.
"There is no other creative software application on
the market that offers consumers new and unique
ways to experience creative multi‐touch features
complementing Windows 7 in the way that Corel
Digital Studio 2010 does. Windows 7 & Corel make
new things possible" Christian Georgeson, Windows
Consumer Product Manager at Microsoft.

Pricing and Availability
Corel Digital Studio 2010 is now available globally in
English, German, French, Italian, Dutch, Spanish and
Chinese Traditional as an electronic software
download (ESD) at a SRP of £59 incl. VAT. Corel
Digital Studio 2010 will also be available at leading
retailers around the world starting in mid‐September
2009. For more information, to purchase an ESD or
download a free, fully featured 30‐day trial, please
visit www.corel.com. The individual photo and video
components of Corel Digital Studio 2010 can also be
purchased as standalone products. Corel® PaintShop
Photo Express 2010 is available TM at a SRP of £29
incl. VAT and Corel® VideoStudio® Express 2010 £39
incl. VAT.

Corel Digital Studio 2010: Create Amazing Photo
and Video Projects in Minutes
You don't have to master overly complex software
programs or spend hours working on your projects.
Corel Digital Studio is designed specifically for users
who value simplicity and want results fast.
•

•

Movie Making Made Easy: Finally, movie
making is something everyone can enjoy.
With its simple interface and intuitive
controls, Corel Digital Studio offers a
groundbreaking, visual approach to video
projects that makes it easy for anyone to
enhance and share favourite video
memories ‐‐ even in HD.

EQUIPMENT
SIGMA 70‐300MM F4‐5.6 DG OS

Creative Photo Projects: Thrill friends and
family with beautiful photo books and
calendars that you can create in just
minutes from within Corel Digital Studio.
There's no lengthy online uploading process
to slow you down when you want to get
creative. Instead, you can focus on your
memories, create your project and when
you're done, print at home or have your
creation professionally printed using Corel's
online service.*

Compact, optically stabilised, telephoto zoom lens

Sigma released a new 70‐
300mm F4‐5.6 DG OS.
This telephoto zoom lens
incorporates
Sigma’s
original OS (Optical
Stabiliser) function and is
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housed in a compact construction.

Panasonic has added a powerful new model, the
DMC‐GF1, to its LUMIX G Micro System lineup of
next‐generation digital interchangeable lens
system cameras. Distinguished by an artistic flat
body that is both elegant and compact, the new
DMC‐GF1 debuts as the world's smallest and
lightest system camera with a built‐in flash*1. The
new GF1 takes its place as the third model in the
revolutionary G series of digital interchangeable
lens system cameras based on the Micro Four
Thirds system standard. Panasonic took the market
by storm with the series' first model – the DMC‐G1,
with its convenient size and brilliant image quality.
The company broke more new ground when it
launched the DMC‐GH1, which added creative
AVCHD full‐HD movie recording.

The OS function offers the use of shutter speeds
approximately 4 stops slower than would otherwise
be possible. It makes telephoto shooting easy for
many types of photography such as sport and nature.
For Sony and Pentax mount, the built‐in OS function
of this lens can be used even if the camera body is
equipped with an anti‐shake function. As
compensation for camera shake is visible in the view
finder, the photographer can easily check for
accurate focus and ensure there is no subject
movement.
The SLD (Special Low Dispersion) glass element
provides excellent correction for all type of
aberrations. The Super Multi‐Layer Coating reduces
flare and ghosting and provides high contrast images
throughout the focal range.
The lens has an overall length of 126.5mm (5.0”),
maximum diameter of 76.5mm (3.0”) and weight of
just 610g. Its compact construction makes it
convenient for travel and hand held telephoto
photography. This lens’ rounded 9 blade diaphragm
creates an attractive blur to the out of focus areas of
the photograph.
This lens has a minimum focusing distance of 150cm
(59.1”) throughout the entire
zoom range and a maximum magnification ratio of
1:3.9, making it ideal for close‐up photography.
Features:
Equipped with Sigma’s own OS (Optical Stabiliser)
function
SLD glass for excellent correction of aberrations
Super Multi‐Layer Coating reduces flare and
ghosting
Compact construction
For use with full frame and APS‐C digital SLRs

The newest family member DMC‐GF1 is
sophisticated in form, offers an extensive function
set, provides uncompromising performance, and
delivers the ultimate in operating and shooting
ease. The GF1 thoroughly optimizes the
advantages of a system camera to assure
outstanding image quality. It can record both vivid
still shots and smooth, beautiful motion pictures.
The GF1 features the advanced AVCHD Lite movie
mode, which is ideal for recording extended HD
movies and networking with other AV devices, and
it can also record in the Motion JPEG format, which
offers wide compatibility with PCs.
As the "artistic flat" body description suggests, the
slim GF1 puts a palette of creative possibilities in
the user's hands. When shooting either still photos
or movies, for example, users can select from
several preset filters in My Colour mode or apply a
range of unique textures available in Film mode.
In addition to a host of beginner‐friendly shooting
assisting functions, such as LUMIX's popular iA
(Intelligent Auto) mode, the DMC‐GF1 also comes
with unique functions including exposure meter,
aperture preview and shutter speed preview
through the live view. A number of accessories,
starting with the Live View Finder which provides
full‐time live view, makes photography more fun
while expanding the user's artistic capabilities.

PANASONIC DMC‐GF1, A NEW CAMERA
FOR THE LUMIX G MICRO SYSTEM

With its unlimited possibilities and choice of three
attractive body colours, the easy‐to‐carry GF1 will
please users of every level. Experienced
photographers will find the GF1 an ideal everyday
camera in the bag anytime and those new to
system cameras will find that it gives them the
potential to explore realms of photography far
beyond the limits of compact cameras.
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The world's smallest and lightest digital
interchangeable lens camera with built‐in flash in
an artistic flat design*1
The GF1 does away with the pentaprism found on
other standard interchangeable lens cameras. This
mirror‐less structure helped Panasonic achieve a
neo‐classic body design that dramatically reduces
both size and weight. Designed for maximum
thinness, the GF1 reduced 35% in the volume and
26% in the weight of the DMC‐G1, up until now the
most compact G model.

For the image processing LSI, the new Venus Engine
HD features exceptionally advanced signal processing
capabilities. This sophisticated LSI separates
chromatic noise from luminance noise and applies
the optimal noise reduction to each, so you capture
clear and beautiful images even when shooting at
high ISO sensitivity levels. The Venus Engine HD also
provides independent gradation control for each of
the R, G and B colours, so even delicate colour
nuances are reproduced faithfully. Linking smoothly
with the Live MOS sensor, the Venus Engine HD
records stunning high‐resolution 12‐megapixel
images with exceptional accuracy. Signals containing
a large amount of image data are sent from the Live
MOS sensor to the optional Live View Finder at 60
fps, resulting in clear, smooth live view. The Venus
Engine HD also supports an extensive range of
functions, including HDMI output.

While the GF1 is small in size, it does not
compromise on functions. It comes equipped with a
built‐in flash. It boasts a large, 3.0‐inch Intelligent
LCD with a wide viewing angle and full 460,000‐dot
resolution. Users enjoy vivid, exceptionally detailed
images both when shooting and when viewing the
results. The Intelligent LCD also offers extremely fine,
automatic backlight control, which combines with
the high resolution to assure outstanding viewing in
everything from sunny outdoor conditions to dim
indoor situations. The GF1 is compatible with an
optional Live View Finder(DMW‐LVF1), which
provides the full‐time live view function boasting
100% field of view regardless of the lens to attach.

The cameras of Lumix G Micro System are equipped
with a highly efficient Dust Reduction system, If dust
or other foreign matter gets inside the camera when
you're changing lenses, it could cling to the image
sensor and show up as a spot in your photos. The
Dust Reduction System in the GF1 helps eliminate
this possibility by placing a supersonic wave filter in
front of the Live MOS sensor. Vibrating vertically
around 50,000 times per second, the filter repels
dust and other particles effectively.
A pallet of options to stimulate photographers’
creativity
The DMC‐GF1 is artistic not only in form, but also in
function. It provides an array of features that let
users either capture precisely true‐to‐life images or
create their own beautifully expressive images. The
GF1 newly features My Colour mode with a total of
seven preset effects – Expressive, Retro, Pure,
Elegant, Monochrome, Dynamic Art, and Silhouette
while inheriting the previous Custom mode, which
lets users manually set the colour, brightness and
saturation levels.

Panasonic paid meticulous attention to operating
ease when designing the GF1. The drive mode lever
and rotary/click dial are considerately placed for
operation with minimal finger movement. The
precise button placement and simple, logical menu
interface work together to make operation easy and
intuitive.
LUMIX G Micro System cameras come in a choice of
body colours: true black, active red and sleek silver.
With other body parts crafted of finely textured
aluminum, G series cameras have a high‐quality
appearance to be attractive while it is exceptionally
practical design. The DMC‐GF1 is absolutely the
camera that gives every photographer a pleasure to
own.
High image quality as an interchangeable lens
system camera
While achieving breakthroughs in advanced
functions and compactness of design, Panasonic also
refined its comprehensive digital imaging
technologies. As a result the level of image quality
that rivals or even surpasses D‐SLR cameras. The 4/3‐
type 12.1‐megapixel Live MOS sensor featured in the
DMC‐GF1 offers the best of both worlds ‐ the
superior image quality of a CCD sensor, and the
lower power consumption of a CMOS sensor.
Advanced technology that makes it possible to read 4
channels of data simultaneously also helps the GF1
deliver 60 frames‐per‐second Full‐time Live View
images, while faithfully reproducing high‐resolution
images with fine detail and rich gradation.

With the Live View function, users can see how these
settings will affect the photo before they shoot,
making it easier to capture the exact mood or
atmosphere desired. For even more elaborate
effects, users can choose from a total of nine Film
modes, and set the contrast, sharpness and
saturation levels for each. A custom function lets
users store their favorite settings in memory. The
GF1 also provides a total of 16 Scene modes,
including a new Peripheral Defocus mode that keeps
the subject in sharp focus while gently softening the
focus around it. These modes can be used when
shooting motion images too, letting users create
movies with dramatic, theatrical effects without
having to edit after they shoot.
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•

Some functions may not be available
depending on the lens that is mounted.
• When you set the picture quality to HD,
WVGA or VGA, we recommend using a high‐
speed card with "10MB/s" or greater
displayed on the package.
• Motion pictures can be recorded
continuously for up to 29 minutes 59
seconds in some countries.
• Continuous recording exceeding 2GB is not
possible when recording motion JPEG.
Remaining time for continuous recording is
displayed on the screen.
• AVCHD Lite motion images recorded onto
an SD Memory Card or a DVD disc cannot
be played from a device that does not
support the AVCHD standard.
Contrast AF system to realize advanced functions
The contrast AF system adopted in the DMC‐GF1
features not only the accuracy but also the industry’s
fastest level of high‐speed, (e.g. Approx. 0.3 sec with
a Lumix G standard zoom lens H‐FS014045.) There
are many reasons to employ contrast AF for its
focusing system, including full‐time live view.

The exposure meter can be displayed in the P/A/S/M
shooting modes. The correlation between shutter
speed and aperture is shown, with a colour‐coded
warning that alerts users when the settings are not in
the proper range. For newcomers to system camera
photography, this makes it easy to learn proper
settings both visually and logically, enhancing their
photography skills.
Take motion picture recording to the next‐level
with new generation AVCHD Lite
The DMC‐GF1 can record 1280 x 720 high‐definition
motion picture in AVCHD Lite that features long
recording time and high compatibility with audio‐
visual equipments. Uses can enjoy recording HD
motion images taking maximum advantage of lens’
descriptiveness and interchangeability or the large
sensor size. The action starts at a single press of a
dedicated button on the top while most of the
settings for photo recording are succeeded, which is
convenient when you record the same subject at the
same situation in both photo and movie. HD Motion
JPEG in 1280 x 720 can also be selected as an
alternative movie recording format in addition to
QVGA, VGA and WVGA, which is more compatible
with PCs.

Users can choose from a wide range of AF modes,
including multiple‐area AF with up to 23 focus areas,
1‐area AF with a selectable focus area, Face
Detection, and AF Tracking. In the 1‐area AF mode,
the AF frame size can be changed by simply turning a
dial. The GF1 also has a Quick AF function that begins
focusing as soon as the user aims the camera ‐ no
waiting for the user to press the shutter button
halfway. This provides a quicker focusing that can
help capture the subject before the crucial moment
passes. Continuous AF keeps the subject in focus at
all times. With the GF1's many auto focus modes,
there's an option that's just right for any shooting
situation.
Great photography is not only from a professional
photographer ‐ iA(Intelligent Auto)mode
The DMC‐GF1 has advanced functions that will
satisfy experienced photographers, yet is easy
enough for beginners to use comfortably. It's ideal
for compact camera owners who want to step up to
higher‐quality photos – but without having to carry a
bulky, heavy camera. Panasonic achieved this superb
ease of use by continuing to improve iA mode – with
its shooting assist functions that have proven
extremely popular in LUMIX compact cameras – and
adding it to the LUMIX G Micro System's advanced
imaging technologies.

Even video beginner can record excellent movies
with DMC GF1 because the popular iA (Intelligent
Auto) is also available motion image recording.
Optical Image Stabilizer (O.I.S.) helps prevent
handshake when using high‐powered zoom. Face
Detection automatically detects a face in the frame
and adjusts focus, exposure, contrast, and skin
complexion on it so it always turns out beautifully.
Intelligent Exposure continually checks the ambient
light level and adjusts the exposure setting as
conditions change to prevent blown highlights and
blocked shadows. And Intelligent Scene Selector
automatically switches between Normal, Portrait,
Macro, Scenery, and Low Light modes according to
the situation to optimize visual quality.
The GF1 also provides a colour mode, film mode and
carries over 11 different scene modes from photo
scene modes in movie recording. Motion picture
Program mode that lets you change the aperture and
the shutter speed for more creative HD movie
recording. You can try professional‐like movie
recording with these variety of options like you do
with photo recording.
In AVCHD Lite recording, you can select from three
levels of motion image quality: SH (17 Mbps), H (13
Mbps) and L (9 Mbps). A Wind Cut function is also
available to block out most of the noise from
background wind.

With the Face Recognition*2 function, up to six
people's faces can be registered, and up to three can
be simultaneously recognized to show their names
once registered. Three face images can be registered
for each person, to dramatically raise the detection
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accuracy. Once completed, if the familiar face
appears into your frame again, the camera will
display the name you specified for the person and
prioritize focus and exposure so that the registered
face is bright and in sharp focus.
You can also specify the age of the registered subject
and have both the name and the age of the subject
stamped onto your photos. In playback, you can
choose to display only photos that contain a specific
registered face using Category Playback. You can also
view image slideshows of only a selected person.
Face recognition makes sorting archiving incredibly
easy. This advanced face detection system also
digitally corrects unwanted red‐eye during recording.

assortment of lenses becoming available, the
expressive possibilities are unlimited. The LUMIX
DMC‐GF1 system camera offers a wide variety of
options to choose from to match every shooting
situation and shooting style. Notably, the hot shoe
on the top lets you attach the optional tilt‐shift Live
View Finder (DMW‐LVF1) of 1.04x (0.52x*3),
202,000‐dot, 100% field of view.
Accessories*4:
• Live View Finder: DMW‐LVF1 NEW
• External Flash: DMW‐FL220(GN22) / DMW‐
FL360(GN36) / DMW‐FL500(GN50)
• PL Filter: DMW‐LPL46
• ND Filter: DMW‐LND46
• MC Protector: DMW‐LMC46
• Mount Adapter: DMW‐MA1, DMW‐MA2M,
DMW‐MA3R
• Battery Pack: DMW‐BLB13
• DC Cable: DMW‐DCC3
• Remote Shutter: DMW‐RSL1
• Leather Lens Case(for GF1 with 20mm lens):
DMW‐CGL1 NEW
• Leather Lens Case(for GF1 with 14‐45mm
lens): DMW‐CGL2 NEW
• Soft Case: DMW‐CG3 NEW
• Leather Body Case: DMW‐CGB1
• Soft Bag: DMW‐BAG1, DMW‐BAL1
• Shoulder Strap (Stylish): DMW‐SSTG1‐
A/C/R/K
• Shoulder Strap (Woven): DMW‐SSTG2‐W
• Shoulder Strap (Leather): DMW‐SSTG3‐T
• Shoulder Strap (Leather): DMW‐SSTL1
HD photos and HD movies with VIERA Link
networking
Both still images and motion images in AVCHD Lite
recorded on SD Memory Cards are easy to view on a
Panasonic VIERA TV with dynamic full‐HD resolution.
The user simply inserts the card into the VIERA Image
Viewer (SDHC/SD card slot) on a VIERA TV or DIGA
Blu‐ray Disc Player to play the content. Alternatively,
an optional mini HDMI cable can be used to output
still and motion images recorded with the LUMIX
DMC‐GF1 directly to the TV for easy VIERA Link
operation.

With AF Tracking, the GF1 can lock onto any subject
and keep it in focus even if it moves ‐ making it easy
to get beautiful, clear shots when a great photo
opportunity suddenly arises. Simply aim, lock, and
shoot.
In addition to the advanced functions mentioned
above, the iA mode inherits fundamental functions
users need in a good digital still camera. These
include MEGA O.I.S., which helps prevent blurring
from hand‐shake, and Intelligent ISO Control, which
reduces motion blur by adjusting the ISO sensitivity if
the subject moves as the shot is taken.
Intelligent Exposure optimizes the exposure for each
part of an image, preventing blocked shadows and
blown highlights and helping ensure that gradation
and details are reproduced beautifully. It now
features an automatic backlight compensation
function that activates whenever the camera detects
the subject is in backlight. Intelligent Scene Selector
automatically detects the four most common
shooting situations ‐ Portrait, Scenery, Close‐up and
Low‐light ‐ and switches to the appropriate Scene
mode.
The user can activate all of these useful, convenient
shooting‐assist functions by simply selecting iA
mode.
Rich options for expandability
The Micro Four Thirds System products are joining
today's Four Thirds System products to provide
customers with even higher levels of performance in
a digital interchangeable lens camera. In addition to
LUMIX G lenses, the LUMIX DMC‐GF1 and LUMIX G
Micro System can use any interchangeable lens that
complies with the Four Thirds standard via an
optional mount adaptor DMW‐MA1 and with the
prestigious Leica M/R Lenses via DMW‐MA2M or
MA3R.*3 This gives the user access to a huge range
of compatible lenses.

This makes it possible to take maximum advantage of
the camera's playback functions, including
slideshows in which both still and motion images are
played sequentially, or calendar displays and so on.
All control is possible using only the TV's remote
control.
In addition, with the included software
PHOTOfunSTUDIO 4.0 HD Edition, it is easy to view
and edit your recorded contents. You may also
choose to upload your videos to YouTube or burn
them to a DVD disc for archiving.

With the LUMIX G Micro System and the growing
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About Included Software PHOTOfunSTUDIO 4.0 HD
Edition
The latest version of the exciting bundled software
PHOTOfunSTUDIO 4.0 HD Edition allows you to view,
edit and archive your captured contents with greater
ease and fun. The new PHOTOfunSTUDIO 4.0 HD
Edition features dramatic speed‐up of operation by
achieving 10x as fast as the previous edition for start
up and 8x for initial image registration process*5.
The GUI is re‐designed by adopting simple graphic
elements and layouts as well as the incorporation of
wizard method, making the operation more intuitive
and extremely easy.

Memory Card or a DVD cannot be played on a device
that does not support the AVCHD standard.

NEW LENSES FOR THE LUMIX G MICRO
SYSTEM
LUMIX G 20MM / F1.7 ASPH LENS

Still and motion images can be transferred to the PC
via a USB cable for viewing and archiving on the PC
with the PHOTOfunSTUDIO 4.0 HD Edition installed.
Using PHOTOfunSTUDIO 4.0 HD Edition, you can edit
and remove unwanted portions of your video clips
recorded in AVCHD Lite. Contents recorded in AVCHD
Lite can be burned directly onto a DVD for viewing
on a Blu‐ray Disc player*6. Alternatively, you can use
the software to convert your contents to MPEG2
format to burn onto a DVD.
The portrait images taken with the camera's Face
Recognition function are organized neatly in the
folder of the name registered with the camera. Not
only that, the software also features an independent
Face Recognition function that recognizes the faces
in the picture stored in your PC to sort the photos by
the face speedily. You do not have to pick out each
photo one by one out of thousands of photos when
you only want pictures of a specific person. With
PHOTOfunSTUDIO 4.0 HD Edition, the software
automatically sorts your images into virtual folders
based on the faces you registered. You can also enjoy
slideshows with a variety of effects and use your
iTunes music library as background music. Motion
pictures can be uploaded directly to YouTube using
the built‐in YouTube uploader.
*1 For a system camera with a built‐in flash as of
September 2, 2009
*2Turn Face Recognition item ON and resister the
person with full‐face portrait on the shooting menu
in advance. Refer to back page for detail. Some
functions in iA mode may not be available depending
on the lens that is mounted.
*3 35 mm camera equivalent. Some functions on the
DMC‐GF1 are not available depending on the lens
that is mounted.
*4 Some accessories are not available in some
countries.
*5 Panasonic in‐house comparison. The speed may
vary depending on the specifications of PC and the
number of images stored in the PC and other
condition.
*6 AVCHD Lite motion images recorded onto an SD

Panasonic unveiled a new pancake interchangeable
lens called the LUMIX G 20mm / F1.7 ASPH. (35mm
camera equivalent: 40mm) as a new member of the
LUMIX G Micro System. The new LUMIX G 20mm /
F1.7 ASPH. Features a dramatic compactness and
light weight despite its F1.7 brightness allowing a
beautiful soft focus for photos to be even more
impressive.
Comprising of seven lenses in 5 groups, the new lens
system uses two aspherical lenses most effectively to
minimize both distortion and chromatic aberrations,
achieving super high resolution corner to corner. The
versatile 20mm of focal distance(Equivalent to 40mm
on a 35mm film camera) is suitable for wide variety
of occasions from daily snapshots including sceneries
like sunsets and dimly lit indoor shots to the
deliberately creative shots taking advantage of its
beautiful soft focus.
When mounted on the LUMIX G Micro System
Cameras, the LUMIX G 20mm / F1.7 ASPH. allows use
of the advanced contrast AF system, which includes a
Face Recognition function, for more convenient,
more enjoyable shooting.
Seven blades give the aperture a rounded shape that
produces an attractively smooth effect in out‐of‐
focus areas when shooting at larger aperture
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settings. The new LUMIX G 20mm / F1.7 ASPH. lens
also features a highly reliable metal mount, and uses
multi‐coated lens elements that minimize ghosts and
flare to further enhance its optical performance.

The closest focusing distance can be instantly
changed to 15cm or 50 cm(0.5 ft to 1.64 ft) with the
switch on the lens barrel according to the shooting
opportunity. The LEICA DG MACRO‐ELMARIT 45mm /
F2.8 ASPH. / MEGA O.I.S. lens also excels in portraits,
middle‐range snapshot, or landscapes in addition to
the original full life‐size macro shots.

LEICA* DG MACRO‐ELMARIT 45MM / F2.8
ASPH. / MEGA O.I.S.

When mounted on the LUMIX G Micro System
Camera, the new lens allows use of the advanced
contrast AF system, which includes a Face
Recognition function, for more convenient, more
enjoyable shooting. Seven blades give the aperture a
rounded shape that produces an attractively smooth
effect in out‐of‐focus areas when shooting at larger
aperture settings.
The new LEICA DG MACRO‐ELMARIT 45mm / F2.8
ASPH. / MEGA O.I.S. lens also features a highly
reliable metal mount, and uses multi‐coated lens
elements that minimize ghosts and flare to further
enhance its optical performance.
* LEICA is a registered trademark of Leica
Microsystems IR GmbH. ELMARIT is a registered
trademark of Leica Camera AG. The LEICA DG lenses
are manufactured using measurement instruments
and quality assurance systems that have been
certified by Leica Camera AG based on the
company's quality standards.
** Four ThirdsTM and Micro Four ThirdsTM, and
Four Thirds and Micro Four Thirds Logo marks are
trademarks or registered trademarks of Olympus
Imaging Corporation, in Japan, the United States, the
European Union and other countries

Panasonic also unveiled a new macro lens of world
renowned Leica name LEICA* DG MACRO‐ELMARIT
45mm / F2.8 ASPH. / MEGA O.I.S. (35mm camera
equivalent: 90mm) for another member of the
LUMIX G Micro System.
Awaited long from enthusiastic photographers
worldwide, the new LEICA DG MACRO‐ELMARIT
45mm / F2.8 ASPH. / MEGA O.I.S. boasts a superb
image quality with minimum distortion, chromatic
aberrations as well as ghosts and flares that passes a
stringent Leica standard to goes beyond their
expectations.

TAMRON LAUNCHES STABILIZED 17‐
50MM F2.8 ZOOM

The new lens system uses both an aspherical lens
and an ED len in its fourteen lenses in ten groups to
realize outstanding compactness, taking advantage+
of the Micro Four Thirds standard to achieve
dramatic downsizing while minimizing distortion and
chromatic aberration.

Tamron has announced a
revised version of its
popular 17‐50mm F2.8 fast
standard zoom for APS‐
C/DX SLRs, which now
incorporates optical image
stabilization (or as the company calls it, Vibration
Compensation). The SP AF 17‐50mm F/2.8 XR Di II VC
LD Aspherical [IF] offers a useful wide angle to short
telephoto range of 26‐78mm (35mm equivalent) in a
compact design scarcely larger than its unstabilized
predecessor. The 19 element / 14 group optical
design employs a host of special elements to
minimize aberrations, and features a minimum
focusing distance of 0.29m over the entire zoom
range, with a maximum magnification of 0.21x. It will
be available in Nikon mount (with a built‐in focusing
motor) from mid‐September, with a Canon version to
follow.

Panasonic's Mega O.I.S. (Optical Image Stabilizer)
suppresses the blurring that is commonly caused by
hand‐shake, making it easy to shoot clear shots for
sharply focused macro shot or in dimly lit places
without using a tripod.
It incorporates inner focus system of three groups of
floating structure, which enables excellent resolution
and contrast without changing its overall length from
full life‐size magnification to infinity. The inclusion of
stepping motor makes the focusing action smooth
and silent for use in both photo and movie recording.
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button.
The EOS 7D also incorporates a new metering
system. The Focus Colour Luminance metering
system (iFCL) intelligently measures focus, colour and
luminance, across 63 zones. Complementing the 19
AF points, the dual layer sensor is able to gather
information from each distinct zone to obtain a more
accurate and consistent exposure.

CANON LAUNCHES THE EOS 7D

Capture images exactly as you see them
The Canon EOS 7D features an Intelligent Viewfinder
that offers photographers 100 per cent frame
coverage. With 1.0x magnification* ‐ a first for EOS ‐
photographers see a large bright image that helps to
fully immerse them within the shot. A transmissive
LCD incorporated in the viewfinder allows
photographers to choose between various overlay
features ‐ such as AF points, the spot metering circle
and composition grid – providing a range of tools
that help when framing a shot. The EOS 7D is also
the first EOS to introduce a Dual‐Axis Electronic Level
– in the viewfinder and on the LCD ‐ that indicates
both pitch and roll angles. This feature is particularly
useful when shooting landscapes to ensure a level
horizon, or when used in conjunction with a Tilt and
Shift lens to level the camera.

Canon unveiled the EOS 7D digital SLR camera – a
completely new design to meet the specific demands
of photographers. Incorporating a new 18MP APS‐C
CMOS Sensor, developed by Canon, the EOS 7D also
features: Dual “DIGIC 4” processors to offer fast,
high‐quality performance in all light conditions, an
ISO range expandable to 12,800 and continuous
shooting at 8 frames per second – without the need
for additional accessories. Impressive technologies
are matched by excellent build‐quality designed with
the photographer in mind – to create a whole new
photographic experience.

The camera features a new 3 inch Clear View II LCD
screen with a solid structure screen, designed to
combat glare by removing the air‐gap between the
LCD’s protective cover and the liquid crystal. This
new screen has a viewing angle of 160 degrees and is
effective even in bright light. As with the EOS 5D
Mark II, an ambient light sensor on the side of the
screen can set brightness automatically depending
on the environment.

During extensive development Canon went back to
the drawing board, listening to photographers
worldwide in order to design the EOS 7D to meet
their specific needs. Commenting on the creation
of the EOS 7D, Mr. Shinbori, Deputy Group Executive
of Photo Products Group & Senior General Manager
of Camera Development Center, Canon Inc,said “We
consulted over 5,000 photographers worldwide and
asked them what they most wanted to see from a
camera. Matching this insight with cutting‐edge
technology, we were able to develop a camera that
truly gives photographers the versatile tool they
require to experiment with their images.”
Accurate Images – High performance AF and
metering systems
The EOS 7D features a 19‐point cross‐type AF sensor,
enabling photographers to achieve accurate shots
and optimise composition options. This improved AF
system offers a range of manual and automatic
settings including Zone and Spot AF to track and
capture subjects quickly and accurately. AF settings
are highly customisable, allowing for rapid reaction
to changes in the scene. Different AF points can be
set for vertical or horizontal orientation, so
photographers can automatically switch between
landscape and portrait shots without touching a

Experiment creatively with light
The Canon EOS 7D is equipped with an Integrated
Speedlite Transmitter. For the first time in an EOS,
photographers can control external Speedlites with
no additional accessories ‐ ideal for those looking to
experiment with creative lighting set‐ups. The EOS
7D also features an extensively upgraded, built‐in
flash including manual control, and wider flash
coverage to cover focal lengths as wide as 15mm.
Customise your individual camera experience
The EOS 7D has been conceived and designed with
the photographer’s needs in mind. The look and feel
of the camera has been aesthetically and
ergonomically crafted to offer photographers the
very best interaction. To this end, the photographer
can design their own experience – camera
operations are customisable, allowing the user to
assign frequently used functions and settings to
convenient controls. This enables photographers to
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save time when shooting critical moments, by
changing settings quickly.
Impressive Features, Impressive Images

Canon CMOS sensor
The EOS 7D includes a new 18 megapixel CMOS
sensor with a wide ISO range that delivers excellent
results in both the low and high‐speed ranges as well
as improved image quality. The sensor is a standard
APS‐C size (22.4x14.9mm) and produces an effective
field of view of 1.6x the lens focal length.
The EOS 7D sensor features condensed circuitry with
improved sensitivity and increased capacity of the
photodiodes, which enables shooting at high ISO and
prevents overloading when shooting in bright
conditions. The ISO range (100 ‐ 6400) is expandable
to 12800 enabling photographers to capture subjects
in their natural light without the use of a flash.
The EOS 7D sensor includes gapless microlenses that
have been moved closer to the photodiodes. These
technological advances, which were developed and
manufactured by Canon, improve the signal to noise
ratio creating very clean high ISO images.
19‐point cross‐type AF system including Spot AF
The AF system has been completely redesigned using
the same architecture as the EOS‐1 series and
includes a separate processor to handle AF
calculations. This, along with AI SERVO II AF, enables
the EOS 7D to offer accurate, reliable and continuous
shooting at 8fps. Uniquely at this level, all 19 points
in the EOS 7D AF sensor are cross‐type points with
f/5.6 or faster lenses, which allows sophisticated
tracking, accuracy and performance throughout the
frame.
EOS 7D also includes Spot AF, a new mode that uses
a smaller area of the sensor to determine focus. This
is useful for small subjects where there is
background detail that can distract the AF sensor. It
also includes Zone AF which limits automatic
selection to one of five zones. This allows
photographers to ensure their subject is
automatically selected.
iFCL metering system with 63‐zone Dual‐layer
Sensor
The iFCL system uses Focus, Colour and Luminance
information to determine consistently exposed
shots. All focus points provide distance information
to the metering system to determine proximity to
the subject and allow the algorithm to weight the
exposure accordingly. EOS 7D has a completely new
metering sensor with 63 zones compatible with 19
AF points. Typically, metering sensors are more
sensitive to red subjects which can lead to
overexposure. EOS 7D combats this with the dual
layer sensor, which has one layer sensitive to red and
green light and one that is sensitive to blue and
green light. The metering algorithm then compares
the level of the two layers and adjusts the meter
reading accordingly.
100% Viewfinder with 1.0x magnification and built
in LCD overlay

The Canon EOS 7D is packed with new features:
• 18 MP APS–C CMOS Sensor
Designed and manufactured by Canon, the
sensor produces an outstanding image and
offers fantastic performance at high and
low conditions, thanks to a new photodiode
and microlens construction.
• 8 fps image capture
Enabled by the Dual “DIGIC 4” processors
and
improved
electrical
system,
photographers can capture images at 8fps,
without the need for additional accessories
and in all file types.
• ISO Range
The EOS 7D enables photographers to
capture subjects in their natural light. The
ISO range (100 – 6,400) is expandable to
12,800.
• EOS Movie
With improved operation, making it easy to
switch directly to movie mode, it is now
even simpler to shoot Full HD video. Users
can set exposure and frame rate – with
options for 24 fps to create that cinematic
feel.
• Dual “DIGIC 4” processors
By utilising Dual “DIGIC 4” processors, users
of the EOS 7D never have to compromise
between shooting speed, image quality and
ISO performance.
• Impressive Design
Canon has listened to photographer
feedback when designing the body, as well
as the internal technologies. A magnesium
alloy body offers environmental protection
– the tough, lightweight construction is
designed to defend against moisture, and
dust – equivalent to the legendary EOS–1N.
The camera is compatible with a wide range of
accessories so it can easily be integrated with a
photographer’s workflow. The Wireless File
Transmitter (WFT‐E5) allows extensive camera
control via a web browser – allowing photographers
to control the camera using a web‐enabled mobile
device.

The EOS 7D is compatible with all EF and EF‐S lenses
as well as Canon EX Speedlites. The Canon EOS 7D
can also be used with Battery BG‐E7, and remote
controllers and switches such as the remote
Controller RC‐1/RC‐5.
* with 50mm lens at infinity, ‐1(1/m) dpt
Technologies Explained:
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The EOS 7D features a high quality viewfinder with
100% coverage and 1.0x magnification ‐ a first for
EOS ‐ making it simple and ease to use. The
viewfinder uses a prism, coating technologies and
eyepiece lenses inspired by the EOS‐1 series.
EOS 7D viewfinder does not have interchangeable
focussing screens. In their place is a Transmissive LCD
Screen ‐ another first for EOS. Through technological
advances Canon has been able to implement the
screen whilst maintaining viewfinder image quality.
This new feature, which can be illuminated in
lowlight, enables grid, spot metering and AF points
to be superimposed upon demand.
EOS Movie
The EOS 7D features an improved movie function
allowing users to record Full HD movies with full
manual control and selectable frame rates. The
operation of the movie function has been improved
to make it easier to use via direct access to settings
with dedicated buttons. AF can now be started by
either half pressing the shutter button or using the
AF‐ON button as before.
The exposure of the movie can be controlled in
Manual mode allowing full control of shutter speeds
and apertures. It is possible to select frame rates
from: 30 (29.97), 25, and 24 (23.976), with 60 (59.94)
and 50 available at 720p. ISO can be set
automatically or manually in the range (100‐6400)
and is expandable to 12800. EOS 7D also allows
users to trim and cut their movies.
Dual “DIGIC 4”
EOS 7D is fitted with Dual “DIGIC 4” processors; the
power of the processors enables more advanced
processing algorithms allowing the camera to
achieve a high performance 8fps at 18 megapixels.
DIGIC 4 removes the highly noticeable colour noise
as well as reducing luminance noise without loss in
detail, allowing for very clean high ISO images. Even
at ISO 6400 noise levels are similar to those of ISO
1600 from DIGIC III. Auto Lighting Optimiser is now
also available during manual exposure, without any
drop in performance.
DIGIC 4 also allows UDMA cards (mode 6) to be used
at their full speed, which allows the EOS 7D to take
advantage of the fastest cards available.

EOS 5D Mark II, an ambient light sensor on the side
of the screen can set brightness automatically
depending on the environment.
Pre‐IFA 2009:Along with the EOS 7D, Canon has
announced two EF‐S, APS‐C lenses. The EF‐S 15‐
85mm F3.5‐5.6 IS USM is as a high quality standard
zoom designed to complement the EOS 7D. It offers
a flexible 24‐136mm (35mm equivalent) range and
offers image stabilizer with a claimed effectiveness
of 4 stops. It also includes ring‐type USM and a close
focus distance of 0.35m through the entire zoom
range. Also bolstering Canon's EF‐S range is the 18‐
135mm F3.5‐5.6 IS USM, which covers a 29‐216mm
(35mm equivalent) range and with a claimed 4‐stop
image stabilizer and a minimum focus distance of
0.45m.
Jump to:
 Additional images and Specifications (EF‐S
15‐85mm f/3.5‐5.6 IS USM)
 Additional images and Specifications (EF‐S
18‐135mm f/3.5‐5.6 IS)

CANON LAUNCHES TWO VERSATILE
LENSES FOR IMPRESSIVE EVERYDAY USE
Canon strengthened its EF‐S series of lenses with the
launch of two powerful standard kit lenses for EOS
EF‐S camera owners: the EF‐S 18‐135mm f/3.5‐5.6 IS
and the EF‐S 15‐85mm f/3.5‐5.6 IS USM. Both lenses
match the style and performance of Canon’s new
APS‐C sensor camera – the Canon EOS 7D.
The high performance standard zoom lens
The
high‐
quality EF‐S
15‐85mm
f/3.5‐5.6 IS
USM
is
equivalent to
a 24‐136mm
focal length
lens
(5.6x
standard
zoom). Designed for EOS EF‐S mount bodies the lens
covers wide angle and portrait focal ranges. It also
offers a 4‐stop Image Stabilizer as well as a close
focusing distance of just 0.35m throughout the zoom
range.

Clear View II
EOS 7D’s 3 inch LCD monitor has 920,000 dots (VGA
resolution) with a viewing angle of 160°. Clear View II
has been designed to combat glare by removing the
air‐gap between the LCD’s protective cover and the
liquid crystal. The air‐gap is filled with an elastic
optical material. This has the affect of suppressing
the reflections from the surface of the liquid crystal,
caused by the sharp change in refractive index, as
light travels through the air‐gap. In order to protect
the liquid crystal from scratches the Clear View II LCD
features a hardened glass cover material. As with the

Versatile super zoom lens
The EF‐S 18‐135mm f/3.5‐5.6 IS is a powerful all‐in‐
one lens for EOS EF‐S mount bodies. It features a 4‐
stop Image Stabilizer and a 7.5x super zoom range
(approx. 29‐216mm equivalent focal length). The
lens covers a wide range of focal lengths with a
0.45m minimum focusing distance. A general‐
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purpose
zoom, it
is ideal
for
photogr
aphers
looking
to make
the step
up from
a
standard kit lens.
Easy‐to‐use impressive image quality
Both lenses offer great low‐light performance due to
the inclusion of a 4‐stop Image Stabilizer that
automatically detects panning and tripods,
responding accordingly to help photographers take
steady shots in any situation. The addition of ultra
low dispersion (UD) lenses and aspherical lens
elements ‐ as well as lens coatings optimised to
combat ghosting and flare ‐ ensure high quality
throughout. Both products also include a circular
aperture for beautiful background blur (bokeh).
Both lenses feature Canon’s improved exterior lens
design that offers an improved high‐grade look and
feel compared with previous EF‐S lenses.
Offering a wide range of focal lengths both EF‐S 18‐
135mm f/3.5‐5.6 IS and the EF‐S 15‐85mm f/3.5‐5.6
IS USM are ideal all purpose lenses, suitable for the
photographer looking for a walk around lens or those
with many lenses who on occasion wish to travel
lighter.

The high quality, medium telephoto macro lens, has
been developed for photographers who demand the
highest level of optical quality. The new Hybrid IS
system features up to 4‐stop correction,
compensating for the effects of camera shake, during
normal shooting. Low friction ceramic balls support
the moving elements, which allows for the amazingly
smooth movement – needed when compensating for
camera shake during macro shooting. Hybrid IS
corrects shift movement – problematic when
shooting up close ‐as well as angular movement
providing photographers with the benefit of up to 2
stops at 1.0x magnification.
The EF 100mm f/2.8L Macro IS USM features ultra
low dispersion (UD) lenses that correct colour
aberration for high resolution, high contrast images
while the addition of Super Spectra coatings
effectively reduce ghosting and flare for superior
quality images. A nine blade circular aperture makes
subjects stand out amid beautiful background blur
and a silent, high‐speed ring type USM Autofocus
motor quickly achieves focus. The lens also includes a
three position focus limiter to tailor the focus system
range to the desired subject.
As part of the L‐series the lens features dust and
water resistant seals. Sitting ahead of the
EF 100mm f/2.8 USM Macro, within the range, the EF
100mm f/2.8L Macro IS USM supports a full range of
accessories including: Tripod Mount D, Macro Lite
adaptor 67, Lens Hood ET‐73 and EF12 II and EF25 II
extension tubes. The tripod mount attaches to the
lens without the need for an adaptor enabling quick
portrait or landscape switching without having to
reframe the camera. Speedlites MR‐14EX and MT‐
24EX can be attached using the MacroLite adaptor.

NEW CANON L SERIES LENS
Canon
also
launched the
high
performance
EF
100mm
f/2.8L Macro IS
USM,
the
latest addition
to
its
prestigious L‐
series, Canon’s
flagship
professional
lens
range.
The EF 100mm
f/2.8L Macro IS
USM
incorporates
image stabilisation in a macro lens for the first time
in the EOS lens range. This enables photographers to
capture stunning close‐up shots without the need for
a tripod.

NEW SONY DSLR‐A850
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In common with all other DSLR cameras from Sony,
the A850 features SteadyShot INSIDE™. This in‐body
optical stabilisation system delivers up to 4 steps of
anti‐shake correction with all compatible lenses,
opening up even greater creative possibilities when
shooting handheld.
Like its full‐frame sibling, the A850 is ruggedly built
for dependable performance in gruelling conditions
with a high‐tensile aluminium chassis and all‐
magnesium alloy body shell. Viewfinder, card slots,
controls and other sensitive areas are protected from
dust and moisture by rubber seals. In addition, a dual
anti‐dust system guards the full‐frame sensor from
the effects of dust entering the body during lens
exchange.
The supplied high‐capacity InfoLITHIUM™ Battery
Pack (NP‐FM500H) delivers power for up to 880
shots (approx.) per charge. Battery levels can be
monitored in precise 1% increments, cutting
uncertainty about remaining shooting time.
The camera can be connected to your BRAVIA™ or
any HD TV (requires optional HDMI cable) for a big‐
screen view of your shots. On‐screen image quality is
optimised for superbly lifelike reproduction on
BRAVIA™ models supporting PhotoTV HD. On‐screen
playback can be controlled via an optional remote
commander.

The new CSLR A850 from Sony offers serious photo
enthusiasts a step up to the creative possibilities of
full‐frame imaging at a compelling price.
Ruggedly built for unflinching pro‐style handling and
performance, the A850 shares the same 24.6
megapixel sensor and virtually all features of the
flagship DSLR‐A900, introduced last year. Like its full‐
frame sibling, the A850 fully exploits the creative
possibilities of the α family of lenses that includes
premium full‐frame optics from Carl Zeiss, plus five
high‐performance G Lens models.
At the heart of the A850 is a full frame 24.6 effective
megapixel Exmor™ CMOS sensor that captures
flawless, detail‐packed images with vibrant, lifelike
colours and fine textures.
The purity of high‐resolution image data captured by
the full‐frame sensor is optimised by two‐stage noise
reduction in both analogue and digital domains.
Noise reduction is first applied as the full‐frame
sensor converts light to electronic signals. Dual
BIONZ™ image engines process large amounts of
digital data, applying finely‐tuned noise reduction
during image processing to deliver pictures with
extremely high level of sharpness and minimal noise
level. This combination of high native sensor
resolution and powerful noise control techniques
ensures superlative image quality, even at high
sensitivity settings up to a maximum ISO 6400 (with
expanded ISO range).
The camera’s optical glass pentaprism viewfinder
aids accurate shot composition, offering an
extremely bright view with minimal distortion and a
generous 98% field coverage.
Serious enthusiasts will also prize the camera’s fast,
high‐accuracy autofocus system that provides
excellent framing freedom while making it easier to
achieve optimum focus with moving subjects. The 9‐
point AF system is supplemented by 10 focus assist
points to assist subject detection, improved out‐of‐
focus detection to reduce focus hunting and a
dedicated F2.8 sensor for enhanced AF accuracy with
wide aperture lenses.
Shots can be viewed on the large, high contrast 3.0‐
inch Xtra Fine LCD that offers an exceptionally high
resolution (921k dot) for critical evaluation – even
outdoors or in bright ambient light.
For greater creative control, an Intelligent Preview
function indicates the effects of exposure, white
balance, and D‐Range Optimiser adjustments prior to
shooting. This Preview is invaluable when composing
complex scenes that may typically combine multiple
light sources with different colour temperatures.
Touching the Fn button switches the display to Quick
Navi mode, allowing convenient one‐handed
adjustment of key shooting parameters. A secondary
backlit LCD panel on the top of the camera body
gives useful confirmation of major settings, even
when the main LCD is turned off.

The choice of full‐frame lenses to complement the
A850 is enhanced with the new 28‐75mm F2.8 SAM.
This compact, easy‐to‐carry lens is ideal for photo
enthusiasts looking to add a bright, general purpose
zoom to their collection of full‐frame optics.
Delivering excellent imaging quality at an accessible
price, it’s the first zoom for the Alpha range offering
a wide F2.8 aperture over its entire zoom range.
Ideal for day‐to‐day shooting tasks, its bright
maximum aperture makes the 28‐75mm F2.8 SAM
particularly valuable for interior scenes and
available‐light portraits.
The DSLR‐A850 full‐frame digital SLR camera is
available from September 2009 and the 28‐75mm
lens will be available from November 2009.
Features
• Full‐frame 24.6 effective megapixel Exmor™
CMOS sensor and dual BIONZ processors for
detail‐packed, low‐noise images with high
sensitivity up to ISO 6400 (with expanded
ISO range)
• Bright optical glass pentaprism viewfinder
with 98% coverage
• SteadyShot INSIDE™ offers up to 4.0 steps
anti‐shake performance with all lenses
• Photo quality (921k dot) 3.0‐inch Xtra Fine
LCD
• Fast, high‐accuracy 9‐point AF with 10 focus
assist points
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wo powerful, feature‐packed DSLR cameras from
Sony make it easier than ever to capture beautiful
pictures, carefree family portraits, stunning holiday
memories and action‐packed scenes.

In a DSLR debut, Quick AF Live View now features
Face Detection, prioritising AF on people’s faces and
fine‐tuning exposure/white balance settings for crisp,
beautiful portraits with natural skin tones. Another
DSLR first by Sony that’s already featured on many
Cyber‐shot™ models, Smile Shutter detects faces in
Live View mode, automatically firing the shutter at
just the right moment to capture happy, relaxed
smiles.
A special new Manual Focus Check Live View mode
assists with fine‐tuning your composition. Low‐noise
images can be previewed directly from the CMOS
sensor, allowing critical assessment of focus and fine
detail, even in low light. The live image offers 100%
field coverage, assisted by framing grid lines for
precise composition. There’s also a selectable 7x/14x
zoom function for a close‐up confirmation of focus.

SONY DSLR‐A500 (12.3 MEGAPIXELS)
AND DSLR‐A550 (14.2 MEGAPIXELS)

The A500 offers a crisp, high‐contrast 3‐inch Clear
Photo LCD Plus screen with the same tilt range for
clear, comfortable composition and reviewing shots.
The DSLR‐A500 (12.3 megapixels) and DSLR‐A550
(14.2 megapixels) are packed with advanced Sony
technology that combine the spontaneity and
freedom of Live View shooting with generous
possibilities to realise your creative vision.
At the heart of both cameras is a new Exmor™ CMOS
sensor that ensures crisp low‐noise images, packed
with fine detail and vibrant colours. Sharing
powerful on‐chip noise reduction techniques with
the full‐frame DSLR‐A900, this advanced sensor
works with processing algorithms handled by the
high‐speed BIONZ™ engine to deliver premium
images plus razor‐sharp shooting responses.
Dramatically reduced picture noise now allows
super‐sensitive shooting at up to ISO12800, allowing
attractive results when shooting handheld in
challenging situations like candlelit interiors.

The A550 features a superb (921k dot) 3‐inch Xtra
Fine LCD screen for critical focusing and photo‐
quality viewing with class‐leading colour, contrast
and detailing. The screen tilts up or down over a full
180 degree range, allowing uncompromised ‘free‐
angle’ live view shooting in any position. An ambient
light sensor automatically boosts LCD brightness for
extra screen clarity when surrounding light levels are
high while both cameras also feature a clear, bright
optical viewfinder with wide 95% field coverage for
framing and focusing as an alternative to live view
shooting.
Operation of both cameras is brilliantly simple,
thanks to a redesigned on‐screen interface that
provides easy access to functions and settings during
live view operation. A unique Graphic Display gives a
clear, intuitive indication of how shutter speed and
aperture adjustments will affect the final image.
Creative options are broadened by new Auto HDR
mode that captures a huge range of shadow and
highlight detail in landscapes, interiors and other
scenes. Previously accessible only to enthusiasts
equipped with a tripod and image processing
software, HDR (High Dynamic Range) is a specialist
technique that combines two frames shot at
different exposure settings. The A500 and A550 use
powerful algorithms to combine and optimise two
successive frames in less than 10 seconds, correcting
any misalignment between frames when shooting
handheld. The result is a single HDR image emulating
the huge natural tonal range of human vision – with
no PC or tripod needed.
The D‐Range Optimiser featured in previous DSLR
models has been enhanced for even better results
with backlit portraits and other tricky high‐contrast
scenes. The powerful BIONZ engine now optimises

Thanks to the powerful BIONZ image processing
engine, Quick AF Live View now supports even
speedier shooting responses with rapid, precise
autofocus. This makes it easier than ever to capture
beautifully relaxed portraits, dynamic action shots
and more.
Powered by the BIONZ image processing engine,
fast‐moving action can now be captured effortlessly
with faster continuous shooting speeds. Sustained
shooting speeds of up to 4 fps can be achieved in
Live View Mode, rising to 5 fps with the optical
viewfinder. New Speed Priority mode on the DSLR‐
A550 raises the bar further still, shooting at an
incredible 7 fps (with AF and AE setting maintained
from the first frame ). It’s a powerful creative tool for
capturing the nuances of a portrait subject’s
changing expression or dynamic action sequences.
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image data in real time, processing brightness and
contrast in individual areas of each exposure for
balanced, natural looking results. Optimisation can
also be selected manually from 5 processing levels.
A Smart Teleconvertor button instantly boosts image
size by 1.4x or 2x to etend your camera’s zoom lens
range further for frame‐filling close‐ups.
Like all DSLR cameras by Sony, both new models
feature SteadyShot™ INSIDE, the powerful optical
image stabiliser that cuts the effects of camera shake
by up to 4 stops while shooting handheld with any
lens.
After shooting, it’s easy to to connect both cameras
to your BRAVIA™ television via HDMI (requires
optional cable) for a stunning big‐screen view of your
shots. Compatible BRAVIA™ models automatically
switch to PhotoTV HD mode for optimised still image
playback with incredible detail, colour and clarity.
BRAVIA Sync lets you control image slideshows in
comfort via your TV’s remote.
Both cameras let you capture even more incredible
moments without the worry of running out of power.
The rechargeable battery pack of the A500 allows up
to 1000 shots (CIPA test, approx. figure) – the highest
capacity of any α series digital SLR camera battery to
date. The battery of the A550 delivers up to 950
shots from a single charge.
If you’re hungry for even more shooting stamina, the
new VG‐B50AM Vertical Control Grip holds up to two
NP‐FM500H batteries. This premium grip gives A500
users an incredible 2,000 shot maximum capacity
(A550: 1,900 shots), with automatic switchover
between batteries and accurate display of power
remaining in % increments on the camera’s LCD. An
additional shutter release and dual controls support
comfortable, accurate shooting in either portrait or
landscape positions.

Stick PRO‐HG Duo HX 32GB will never miss the key
shot because the number of pictures taken in 1 min
is approx 270* photos (in RAW+JPEG/L
(12M).Delivered with USB Adaptor, Memory Stick
PRO‐HG Duo HX 32GB is ideal for users who want to
transfer data in high speed: approx. 1700* pictures in
L (12M) size at RAW+JPEG mode in 26 minutes.
The DSLR‐A550 and DSLR‐A500 digital SLR cameras
are available from the end of October 2009.
*these figures are measured under certain
conditions
Features
• New 12.3/14.2 effective megapixel
(A500/A550) CMOS sensor and new
enhanced BIONZ processor for detail‐
packed, low‐noise images with high
sensitivity up to ISO 12800
• High‐speed continuous shooting up to 5fps
(with optical viewfinder) and 7fps in Speed
Priority mode (A550 only)
• Enhanced Quick AF Live View captures fast‐
moving action, with Face Detection for
beautiful portraits
• 180º tilt‐angle 3” Xtra Fine LCD (A550) and
intuitive new interface for clear, simple
shooting
• Manual Focus Check Live View mode for
precise, convenient adjustment of focus
and composition
• Auto HDR mode for high dynamic range
exposures
• Class‐leading shooting stamina (1,000 shots
‐ A500)
• HDMI™ output and BRAVIA™ Sync for
control from TV remote

Also, with Memory Stick™ at the heart of the Sony
alpha, you have every advantage. The advanced
Memory Stick PRO‐HG Duo HX (4GB, 8GB, 16GB or
32GB) is the perfect tool for continuous shooting
mode, with the ideal combination of massive storage
capacity and blisteringly fast operation. Memory

WHAT’S ON – EXHIBITIONS & EVENTS
EXHIBITIONS

POSTCARDS FROM THE TERRITORY
12 September–19 September
PhotoAccess Multimedia Gallery

A selection of entries, including the prize‐winning work, will be
displayed at the National Portrait Gallery and as an online
exhibition from 23 July–13 September 2009.

ANU Rural Medical Society. Postcards
from the Territory showcases the
experiences and work of medical
students while on placements in remote
communities in the Northern Territory.

HUW DAVIES GALLERY
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The exhibition offers a rare glimpse into
the life, culture and landscape of
Indigenous Australians living in the
Northern Territory.

When: 01/09/2009 ‐ 06/09/2009, ‐

FLORIADE 2009
Saturday 12 September to Sunday 11 October

HIY2009 ‐ HANG IT YOURSELF

PHOTOGRAPHIC WORKSHOPS

Everyone will have a chance to show their work
during the PhotoAccess 25th Anniversary
celebrations, when the HUW DAVIES GALLERY will
be the venue for the ultimate open access
exhibition. A photomedia take on street art, HIY
(Hang it Yourself) 2009 will show in the HUW
DAVIES GALLERY from 1 to 20 September 2009.

Morning workshop times
7.00‐9.30am (followed by breakfast at Cafe Valenti)
• Saturday 12 September
• Saturday 19 September
• Saturday 3 October
• Saturday 10 October

HUW DAVIES GALLERY
Manuka Arts Centre
Corner Manuka Circle and New South Wales
Crescent, Griffith (next door to the Manuka Pool)
PO Box 4059 Manuka ACT 2603
Phone:(02) 6295 7810
Opening hours:
10 am to 4 pm Tuesday to Friday
12 to 4 pm Weekends

Twilight workshop times 4.30‐7.00pm (followed by refreshments
at ActewAGL Look and Learn Marquee)
• Wednesday 30 September
• Thursday 1 October
• Thursday 8 October
Workshop format
Workshops will be run by Geoff Comfort and Ben Kopilow, both
members of the Australian Institute of Professional Photography
and experienced photographic lecturers. Geoff and Ben will both
attend each session. The sessions are stand alone and not part of a
series. Short course notes will be supplied to participants. The
sessions will include two hours of hands‐on workshop and a 30‐
minute debrief and photo critique.

We will also have extended opening hours each
week in the evening and weekend. Please call to
find out what extra time we will be open
Email: contact.us@photoaccess.org.au

UPCOMING EVENTS

To get the most value from the workshops it is recommended that
participants bring a camera that has a manual override.

CANBERRA NARA CANDLE FESTIVAL

Workshop numbers
Numbers will be limited to a maximum of 12 participants so book
early to avoid disappointment. Workshops will also require a
minimum number of eight participants to run.
Workshop cost $154 per person (GST inclusive).
Price includes:
• 2.5 hour photography workshop by Geoff Comfort and Ben
Kopilow

Join in the celebration of Canberra's sister city
relationship with Nara, Japan. Fun and interesting activities for
children include origami, calligraphy, didgeridoo and boomerang
painting. You can even make your own Japanese lantern, then
participate in a spectacular lantern procession in the evening. A
variety of Japanese cuisine and beautiful designer Japanese
handicrafts will be for sale. At dusk the scene is set for the event's
centrepiece ‐ more than 2000 floating candles arranged in the dry
riverbed of Canberra Nara Park. As the sun sets, the candles flicker
into the evening sky and illuminate the park with a soft glow.
Where: Canberra Nara Park, Lennox Gardens, Yarralumla
No admission charge.
When: 26‐09‐2009‐09‐
Enquiries: events@act.gov.au
Ph: 13 2281
URL: www.events.act.gov.au

• Breakfast for the morning sessions and refreshments for the
evening sessions
• A Floriade bag containing a Floriade cap and mug.
How to book
Workshops are limited and bookings are essential.
Please download the booking form.
Complete the form and address it ATTENTION TO THE FLORIADE
PHOTOGRAPHIC WORKSHOP COORDINATOR.
Return the form by one of the following ways:
Email susie.dunn@act.gov.au
Fax 02 6205 0629

2009 WORLD MOUNTAIN
TRIALS CHAMPIONSHIPS

BIKE

AND

Post Australian Capital Tourism Locked Bag 2001 Civic Square
Canberra ACT 2608
Terms and Conditions, Booking and payment form (PDF)

Where: Stromlo forest Park
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Experience and be inspired by a rich harvest of workshops and
presentations to inspire throughout Floriade.

HOW TO ENTER
To enter, submit a landscape (horizontal) format
image that represents your community. It can be of
anything – people, teams, landmarks or monuments.

COMPETITIONS
CANON EOS PHOTO 5

Along with your image, please supply your:

•
•
•
•
•

An annual creative photography competition
which all begins with a brown paper box. Inside
there will be items which represent 5 separate
photographic briefs to challenge photographers.
This year we have 5 professional judges and
even bigger prizes - find out more here.

name
postal address
email address
phone number
description of the image in 10 words or less.

ELECTRONIC ENTRIES
Images should be no bigger than 4MB and can be
emailed,
along
with
entry
details,
to
postcards@actewagl.com.au

POSTCARDS FROM YOUR TOWN
Each year ActewAGL and TransACT produce an annual calendar

POSTAL ENTRIES

distributed free to schools, community groups and businesses
throughout the capital region.

Images submitted by post should be a high-quality
laser print or supplied on a CD no bigger than 4MB.
Images and entry details can be posted to:
Postcards From Your Town
ActewAGL and TransACT
Marketing and Corporate Affairs
PO Box 250
Civic Square 2680
Entries close at 5pm on Friday 18 September 2009.

For our 2010 calendar we are looking for the 12 best photos, from
photographers young and old, that best depict life in the towns of
our region.
The winning photos will feature on the 2010 ActewAGL and
TransACT calendar, with each winning photographer pocketing
$500.
Webpage:http://www.actewagl.com/promotions/Postcards/defau
lt.aspx

Competition terms and conditions apply

Position

Person

e-mail address

Phone (ah):

President

Rod Burgess

rodnkym@actewagl.net.au

6292 6698

Sec/Treasurer

Kim Barnabas

gerkims@tpg.com.au

Newsletter Editor

Warren Hicks

hicks@netspeed.com.au

6288 3689

SOUTHSIDE CAMERA CLUB ‐ PHOTOSHOP SIG MEETING TOPICS
2009
September 24

TBA

October 22

TBA
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